
 

 
 

 

 

  

  

  

WT-NX-Interface 

The WT-NX-Interface enables the user to select and transfer assemblies from the 
WinTool database to the NX CAM environment, including full graphic representa-
tion and cutting conditions for the different work materials. 
 
A complete list of every used tool assembly will be stored in the WinTool database 
for further use as setup sheet, documentation and queries. 
 
Requirements 

• WinTool 2011 Professional or later 

• NX 7.5, NX 8.0, NX 8.5, NX 9.0.3 (Details on page 4), NX 10, NX 11, 
NX 12 
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Summary 

Job 
The WT-NX-Interface enables the user to select and transfer assemblies from the WinTool database to the 
NX CAM environment. Full graphic representation for each assembly is supported and the cutting conditions 
for the different work materials are transferred from the WinTool technology library. A complete list of every 
used tool assembly will be stored in the WinTool database for further use as setup sheet, documentation and 
queries.  

Requirements 
This interface requires WinTool Professional 2011 and NX 7.5 or higher and can be used under Windows 
only.  
The user must be granted write access on the NX directories 

• UGII_CAM_LIBRARY_TOOL_METRIC_DIR 

• UGII_CAM_LIBRARY_TOOL_ENGLISH_DIR 

• UGII_CAM_LIBRARY_FEEDS_SPEEDS_DATA_DIR 
The actual directories can be seen by going to "Help" > "Log file". 
 
Note:  

• NX 9 requires maintenance release 9.0.3 for correct import of tool type "Form Drill" and "Probe".  

• Import of tool type "Probe" requires NX 8.0 or higher 

NX 7 or earlier 
To use the interface with NX versions 7 and earlier, the VB.Net macro must be adjusted manually. For de-
tailed instructions, refer to chapter "Adjust tool import macro for NX 7 and below" on page 26.  
Note: WinTool AG doesn't offer support if the macros are changed by the user. 

Principals 
Single assemblies, a list of assemblies or all assemblies related to a specific CNC are transferred from Win-
Tool to NX. The activity is started out of NX by calling a VB.Net macro linked to the "get"-icon shown in the 
NX menu. Tool data is exported in NX format and the tool is directly linked to the active NX part. 
 
The final list of used assemblies is exported from NX to WinTool by using the "put"-icon being linked to an-
other VB.Net macro. 

Tool types supported 
Most of the NX Tool Types are supported by this interface. A detailed list is found in a later section of this 
manual. The NX model for the assembly is transferred from the customer tool parts library. For limitations of 
the shape module see corresponding documentation. 
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Important Changes 

NX 8.0 or later 
Import of shank 
NX 8.0 introduced shanks in milling and drill tool classes. The interface imports shank data starting from the 
front of the tool.  

• It imports the neck if it exists and is different in diameter than the cutting diameter 

• If no neck, but a tapered shank exists, the interface is importing the tapered shank 
 

Face Mill/Chamfer Mill 
In NX 8.0, the tool type "face mill" is replaced by "chamfer mill". The WT-NX-Interface supports this new 
type. If NX 8.0 is used, the classification in the WinTool tool types must be adjusted to ensure that the tools 
are transferred correctly. 
The following table shows the tool types that must be changed. Check if the NX types in the tool classes are 
correct: 
 

WinTool tool class 
NX tool type of WinTool tool class 
 

Old type New type 
NX tool type 

221  face mill /UG0212 /UG0205 Chamfer mill 

222  square shoulder 
cutter 

/UG0212 /UG0201 End mill 

223  chamfer mill /UG0201 /UG0205 Chamfer mill 

 
Note: See chapter "User Classification" on page 19 for details on how to change the classification.  
Chapter Supported NX tool types on page 29 shows all supported types. 
 

NX 7.5 or earlier 
Starting with WinTool 2012, sample databases already contain the new tool types. If NX 7.5 or an older ver-
sion is used, all WinTool tool classes using NX tool type "/UG0205" must be adjusted to import the tool as-
semblies. The NX tool type classes "221  face mill" and "223  chamfer mill" must be changed to the old type 
(see table above). Tool type "225  inch step drill" must be changed to "/UG0212". 
 

Note: See chapter "User Classification" on page 19 for details on how to change the classification. Chapter 
Supported NX tool types on page 29 shows all supported types. 
 

Licensing and Copyright 
You need a signed license agreement from WinTool AG to use the Interface module. 
 
This documentation as well as the software itself is under copyright of 
 
WinTool AG 
Flüelastrasse 7 
CH-8048 Zurich 
Phone: +41 (0)44 401 00 55 
http://www.wintool.com 
  

http://www.wintool.com/
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Installation 

Directory Structure 
WT-NX-Interface 4.7 introduces a clear separation of program files and user data.  
All user data is centrally placed the [Public Documents]\WT-NX-Interface folder: 

User data Location 

Default location of UserModels folder [Public Documents]\WT-NX-Interface\UserModels 

Default location of Exchange folder [Public Documents]\WT-NX-Interface\Exchange 

Default location of CustomToolPath folder [Public Documents]\WT-NX-Interface\CustomTool 

Configuration files: 
WT-NX-Interface.cfg 
WT-MakeList.cfg 

[Public Documents]\WT-NX-Interface 

New Installation of the WT-NX-Interface  
Be sure to be local administrator to install software on a PC. 
 
Install WinTool Professional first and check the functionality. 
 
Install WT-NX-Interface next. Run setup.exe to install the WT-NX-Interface software into a new folder.  
C:\Program Files\WinTool\WT-NX-Interface\ 

 

Note: If the software is running on a server, use separate folders for each Windows user or configure specific 
folders for data exchange (see below). 
 
The software is now installed with the default settings. Continue with the configuration as described in the 
sections below. 

Update Installation of the WT-NX-Interface  

Update from version 4.6 and newer 
Copy the existing configuration files WT-UG-Interface.cfg or WT-NX-Interface.cfg and WT-MakeList.cfg from 
the WT-NX-Interface folder to a safe place. 
 
Uninstall the existing interface and delete remaining files and folders. Install WT-NX-Interface similar to a 
new installation. No adaptations in your NX environment are necessary. 
 
Open the interface configuration via "Start" > "All Programs" > "WinTool" > 
"WT-NX-Interface"> "WT-NX-Interface Configuration" and check the settings. 
 
Move WT-MakeList.cfg back to the interface installation folder. 

Update from version 4.6 or older 
Install WT-NX-Interface similar to a new installation. After the installation, follow one of the two steps to re-
cover the configuration: 

• If the interface was installed in the same directory as the previously installed version, the configuration 
files are automatically moved to [Public Documents]\WT-NX-Interface. 

Check the interface configuration using the configuration window (see page 8) and the configuration file 
"WT-MakeList.cfg". 

• If you chose a different directory for the interface, you must copy the configuration files manually from 
the previous installation directory to the directory 
[Public Documents]\WT-NX-Interface 

The default location of the setting UserModelPath has changed. If you haven't set a UserModelPath in 

the interface configuration, in which case the UserModels folder is in the interface installation directory, you 
must move the contents of the folder to the new default location [Public Documents]\WT-NX-Inter-

face\UserModels. 
Finally, remove the Exchange and UserModels folder in the installation directory of the previous installation. 
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Sample Database 
The WT-NX-Interface always uses the WinTool database currently linked to your WinTool Professional in-
stallation. To test the interface and get familiar with its functionality, please copy a virgin database (WTData) 
from your latest WinTool Professional installation CD. 
 
Re-link this database with the local WinTool application using the function "Change" in the WinTool Admin-
istration section. WinTool will thereafter shut down automatically: 

Use the NX Sample "Side-Frame-mm" stored in the interface "Sample" folder to make your first tests. Before 
you can verify the NC-Program with full assembly representation you have to "get" the tools from the Win-
Tool sample database. Use the WT-NX-Interface and "get" the tool list "Side-Frame".  
 
STL models of the tool holders of the WinTool tools 636106 and 636107 are in the sample folder 

Figure 1 Change the Database in WT-Configuration 
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Figure 2 Instruction for the WT-NX-Interface configuration 

Configuration of WT-NX-Interface 
The configuration window allows you to check and change the settings of the WT-NX-Interface. 
Open the configuration window in "Start" > "All Programs" > "WinTool" > "WT-NX-Interface"> "WT-NX-Inter-
face Configuration" 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
<OK> stores all settings. <Cancel> exits the configuration window without saving. 
 
The configuration window reads and stores settings in the file WT-NX-Interface.cfg which is located in 

[Public Documents]\WT-NX-Interface .This file can also be edited with a text editor.  

 
Additional information on these parameters is found in the section "Configuration file parameters" of this 
manual.  
 
Some of these settings are also stored as Registry Variables. The parameters set in the configuration file will 
be loaded to the Registry Variables when you run the software next time.  
 
Note: Total length of path and filenames must not exceed 255 characters. 
 

Exchange path 
Change the configuration of the data exchange folder if required. The file with the current NX database direc-
tories is stored in this folder. 
OutputPath = C:\Users\Public\Documents\WT-NX-Interface\Exchange  

 
Note: Changes to this configuration are not required if you installed the interface software with default set-
tings.  
Note: Each user must have an individual data exchange path. The information is stored only temporarily and 
should not be written over by other users who work simultaneously.  

User Models path 
Change the path to a location in the network where all NX users can access them. The 2D tool shapes (dxf 
and geo files) are stored in this folder 
UserModelsPath = C:\Users\Public\Documents\WT-NX-Interface\UserModels\  

 
Note: This configuration is not required if the default installation path was used to install the interface soft-
ware.  
 
  

The error icon  indi-
cates a faulty value in 
the cfg file. If it appears 
the settings must be 
changed. The faulty 
value will be corrected 
when you click "OK" 

Comments about 
the data field set-
tings 

Settings not with 
default values are 
white 

Path settings: Click on 
the icon to select a di-
rectory via browser or 
enter path manually 

Settings with de-
fault values are 
gray 
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Cutting Condition Selection 
If SelectCutData is deactivated (False = default), all cutting conditions are transferred. 

 
If this parameter is active (True), cutting conditions for work materials are transferred. 

For tool assemblies, tool lists and machine tools the import uses a different cutting condition selection proce-
dure: 
 

Import Selection procedure 

tool assembly 
data 

The cutting condition window opens and all available cutting conditions can be se-
lected. 

tool list data The interface imports all cutting conditions available for one material only. 
 
If the work material has been assigned to a tool list in WinTool (see folder tab 
"General Data") then the interface imports the tools with the cutting condition for 
this material automatically. 
 
If the work material has not been assigned to a tool list in WinTool, then the cut-
ting conditions selection window appears for the first tool of the list and a value 
must be selected manually. The interface memorizes the work material of the pre-
vious tool and will suggest the same material for the next one.  
 
If a tool has more than one cutting condition for the same material or if no cutting 
condition exists for the material, the interface requests to select one manually. 

machine tools 
data 

The interface imports all cutting conditions available for one material only. 
 
The cutting condition window of the first tool of the machine will be displayed and 
a cutting condition must be selected manually. The material for this value will be 
registered by the interface and is used to preselect the cutting condition for all 
succeeding tools of the machine. 
 
If a tool has more than one cutting condition for the same material or if no cutting 
condition exists for the material, the interface requests to select it manually. 

 
Note: The cutting condition window appears only if there is at least one cutting condition. 
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Transferred Flag 
If the transferred flag is activated, no 2D tool shape is created if the tool was transferred before. (For a de-
scription of the "transferred flag" see later chapter.)  
 
Set the "Ignore_TransferredFlag" to "false" after a longer period of problem free operation. 
 ignore_TransferredFlag = true 

 

Note: The "transferred Flag" should be ignored for installation and tests. 

User specific library paths 
The settings FeedsSpeedsPath, MetricToolDatabasePath and InchToolDatabasePath are obsolete 

since version 4.7.  

T-Prefix for Tool ID 
The Tool Identification is defined as a unique numerical value within WinTool. 
 
A prefix can be defined. It will be automatically set in front of each Tool Identification (e.g. Tool Identification 
is "606012" and prefix is "ID" the Tool Libref will be "ID606012" and the associated 3D Model must be 

"ID606012.prt").  

 
Change the prefix characters if required: 
T-Prefix = ID 

 

Note: No changes are required if "ID" as prefix is accepted. 

 
Note: The 3D model that will be created gets the same name as the tool. That means including the prefix! 

Custom Tool Definitions Path 
Location of the custom tool definition files. Change the path to a location in the network where all NX users 
can access them. Default path is 
C:\Users\Public\Documents\WT-NX-Interface\CustomTool 

 

Configuration of WTMakeList.cfg 
See WT-MakeList manual for details: "Start" > "All Programs" > "WinTool" > "WT-NX-Interface">"WT-
MakeList-Manual" 
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Configuration of NX 

Setup buttons  
Start up NX to find the file which contains directories with NX customizations. Open "Help" > "Log file" (Ger-
man edition: "Hilfe" > "NX Protokolldatei") and search within the log file for the variable "UGII_CUSTOM_DI-

RECTORY_FILE" which stores the path to the customization file, e.g. 
"D:\CAM\NX 8.5\ugii\menus\custom_dirs.dat" 

 
Make sure you have write access for this file and open it with a text editor, e.g. Notepad.  
 
Add the following line at the bottom of the file and save it: 
$WT_NX_Integration_Path 

 
Info: WT_NX_Integration_Path is an environment variable set by the interface installation procedure. It 

stores the directory which contains the menu files, buttons and journals that start the WT-NX-Interface func-
tions "Get" and "Put". The directory is <WT-NX-Interface installation directory>\NX Integration\ 

 
Restart NX and open the NX manufacturing application. Right click anywhere on the menu bar and choose 
"Customize...". Select the "Commands" tab.  

 
NX 8.5 and earlier 
The buttons are in the "WT-NX-Interface" menu bar:  

 
Drag and drop the buttons in 
to an existing toolbar or cre-
ate a new one in the 
"Toolbars" tab and drag the 
buttons into it. 
  

Figure 3 Drag & Drop into a toolbar 
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NX 9 and later 
The "WT-NX-Interface" group is located in "All Groups": 

 
Drag and drop the "WT-NX-Inter-
face" group into a ribbon. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  Figure 4 Drag & Drop into a ribbon 
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Custom Tool Definitions 
Custom tool definitions contain user specific datafield definitions which override the definitions of the WT-NX-
Interface tool types. WT-NX-Interface will search the configured "CustomToolPath" directory for custom tool 
definitions. 

Changing existing tool type 
To change an existing tool type, the files have to be named the same as the configuration within the WinTool 
Class configuration, either preceded with "UG" or with "NX" (both will work) and have the extension ".xml". 
Example: NX0201.xml corresponds to the NX tool type /UG0201. 
 

Creating new tool type based on existing tool type 
If the numbers of the file name don't correspond with a WinTool NX-Interface tool type, a new NX tool type is 
created and displayed in the tool type selection. The new tool type is based on an already existing NX tool 
type with the same parameter values T, ST, UGT and UGST as in the file. 
Example: NX9948.xml with <FieldMapping>attributes T="02" ST ="01" UGT="01" UGST="01" creates a new 
tool type with the type /UG9948, based on the tool type /UG0201. 
 
It will be displayed as a new tool type: 

 
Note: Chapter Supported NX tool types shows all tool types 
 
The example custom tool definition "NX0201.xml" which applies to the tool type EndMill (/UG0201) is in the 
"Sample Data" folder in the WT-NX installation directory. 
  

Figure 5 Select a Tool Style from List 
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Format and language definition 
Tool definition files have the following format: 
Sample: 
<?xml version="1.0" encoding="utf-8" ?> 

<FieldMapping T="02" ST ="01" UGT="01" UGST="01"> 

  <NXParam name="DIA" value="WT(Tools.DMC)" /> 

  <NXParam name="FN" value="WT(PartsNG.Teeth)" /> 

  <NXParam name="HEI" value="WT(PartsNG.CLength)" /> 

  <NXParam name="HLD" value="IIF(WT(Tools.MachineNr)=21, 'HSK_63', '')" /> 

  <NXParam name="OA" value="WT(Tools.CMainArc)+90" /> 

  <NXParam name="RELT"> 

    <SELECT value="WT(PartsCut.CArc)"> 

      <CASE equals="85" value="0" /> 

      <CASE equals="82" value="1" /> 

      <ELSE value="99" /> 

    </SELECT> 

  </NXParam> 

  ... 

</FieldMapping> 

 

XML Structure 
The whole XML content will be wrapped within a "<FieldMapping>" tag. The FieldMapping tag must contain 
the parameters "T", "ST", "UGT" and "UGST" that define the NX target tool type. 
NX target parameters have to be defined as 
<NXParam name="targetName" value="formula" /> 

If a parameter isn't defined within the file and a default definition within the interface for the target tool type 
exists, the default definition from the interface will be taken. 
The following NX parameters will be taken from the interfaces default definition even if no NX target tool type 
is defined within the interface - so it isn't necessary to define them explicitly: 
FORMAT, LIBRF, DESCR, MATREF, MATDES, TLNUM, ADJREG,CUTCOMREG, HLDDES 
 
To be able to output a value based on a certain numerical WinTool value or formula, the SELECT statement 
can be used: 
    <SELECT value="formula"> 

      <CASE equals="value/formula" value="value/formula" /> 

      ... 

      <ELSE value="value/formula" /> 

    </SELECT> 

Usable functions 
Following functions can be used within formulas. They are case-insensitive: 

 
WT(Table.Field) 
The value will be taken from the specified Table/Field from within the WinTool database 
to distinguish between namegiving, cutting and holder part of a tool, the substitutions "Tools", "PartNG", 
"PartCut" and "PartHolder" can be used.  
Boolean fields (e.g.WT(Tools.NonMetric)) are evaluated as numbers: True = 1, False = 0 
Adjustment Values 
"PartNG", "PartCut" and "PartHolder" include the corresponding ToolParts table values "AdjDMVal", 
"AdjZVal", "AdjArcVal" and "AdjXVal". Example: WT(PartNG.ToolPart.AdjZVal) to use the adjustment length 
of the namegiving component. 
Note for users of WinTool 2014 and newer: Use IsNull(WT(PartNG.ToolPart.AdjZVal)) to check if the 
value is empty before using it. Otherwise mathematical operations will fail when WinTool 2014 or newer is 
used. Example: 
"IIF(WT(PartNG.CFreeArc)=0, IIF(IsNull(WT(PartNG.ToolPart.AdjZVal)), WT(PartNG.Zinfluence), 
WT(PartNG.ToolPart.AdjZVal)), WT(Tools.CLength))" 
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IIF(Expression,TrueValue,FalseValue) 
This function is used to select a certain value based on another value. Expression, TrueValue and False-
Value can contain other functions. 
An expression must use one of the following operators to compare values: 

Comparison type Syntax Remarks 

Greater than gt Only numerical values 

Lesser than lt Only numerical values 

Greater than or equals gt= Only numerical values 

Lesser than or equals lt= Only numerical values 

Equals = Numerical and string values 

Not equals != Numerical and string values 

Example: IIF(WT(PartNG.Zinfluence) gt= 0, WT(PartNG.Length), WT(PartNG.Zinfluence)) 

 
Math Expressions 
Supported math operators are: +, -, /, *, sin(), cos(), tan(). 
Brackets '(' and ')' can be used, e.g. (0.5 + WT(PartNG.Zinfluence)) * sin(45) 

 
Defining Text 
To tell the interface that something written as a value within the definition should be directly taken as text, the 
according formula part has to be surrounded by single quotes (' ') 
To concatenate text, use @. Example: WT(Tools.Descript) @ '-Tool' 
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Use of WT-NX Interface 

Import tool assemblies in NX 
In NX, click on the get Button and select a tool assembly, a tool list, or all tools for a machine type. 

 
If no valid user classification is set for a tool assembly, you will be asked to assign a tool type.  

 
If you select "Ignore" to assign to a tool classification, the tool assemblies in this classification will not be 
transferred at all. This is useful for data that must not be transferred to NX, e.g. measuring equipment. 
In most cases it makes sense to assign the mapping permanently to a tool classification. Then you must also 
check the box “Store in assigned Tool Class” (recommended). 
 
Click “OK” to confirm. “Cancel” doesn’t transfer the current tool assembly, “Abort” stops the whole transfer 
process. 
  

Figure 6 WT-ToolExport menu 

Figure 7 Select a Tool Style 
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If the setting SelectCutData (see page 9) is enabled, the cutting conditions are shown and you can select 

the condition which will be transferred with the tool assembly. Press "Cancel" to transfer no condition, "Abort" 
to abort the transfer. 

 
The tool assemblies are imported now and can be used in NX.  
 

Import Tool Assembly Cutting Conditions into Operation 
The following steps are based on NX version 7.5. They can be different on other versions. 
 
To use the cutting conditions associated with a tool assembly in an operation, the following settings must be 
checked in the operation: 

1. The geometry of the operation must use the material of the cutting condition. To select a material go 
to "Geometry"  "Geometry"  "Edit button"  "Material"  "Edit button" 

2. The "Cut Method" of the "Method" must be set to the cutting method of the cutting condition. To select 
the cutting method, go to "Path Settings"  "Method"  "Edit button"  "Cut Method" Edit button. 
Select the appropriate cutting method, e.g. for a milling operation "WT_MILLING" 
Note: If the "Edit button" of the "Method" is not active, create a new method or select a different, ed-
itable method in the list. 

 
The cutting condition data can now be loaded: 
Go to "Path Settings"  "Feeds and Speeds button"  "Automatic Settings"  "More" and click "Reset from 
Table button" to load the data.  
 

If this message is displayed, go through steps 1 and 2 and 
check if the material and the cutting method are correct. 
Then try to load the cutting condition data again. 
 
 
 
 

Figure 9 Error message 

Figure 8 Select an assembly cutting condition from list 
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Export used tools to WinTool 
All tools that are used in an operation will be exported into a WinTool tool list by pressing the Put 
button. 
 
The following window will open: 

 
Select OK to store the information in the WinTool database.  
 

  

Figure 10 Enter a List name in the WT-MakeList 
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Preparations in WinTool Database 

User Classification 
Add the corresponding NX tool type in the data field "Codes for CAM" of each WinTool classification, which 
is used for assemblies in the format: 
/UG0201 

 
In WinTool select in menu "Tools" "Settings" > "Classes", then select the classification.  

See samples in the supplied database and in section "Supported NX tool types" (see Annex). 

Work materials 
WinTool comes with a database of over 1000 work materials structured in about 100 different material clas-
ses. Select the work materials you use and remember the assigned material classification. Later on this will 
help you to easily find and select your work materials to link in your WinTool cutting database.  
 
Note: Missing work materials can be added in WinTool in menu "Tools" "Settings" > "Materials".  

Technology library 
For each tool assembly, cutting data for different work materials can be stored in a table. If for a desired work 
material cutting data is stored, the corresponding values are transferred by the WT-NX-Interface automati-
cally. 
If multiple cutting data is stored for one work material, all of them will be transferred. If the  
setting SelectCutData = true, the cut data is transferred depending on the work material and the import 

mode. 
 
Note: If the files are already present in the destination folder, all technology data will be overwritten. 

Tool Geometry Data  
Be sure to record the tool component data according to the WinTool documentation. 
 
Only classified tool assemblies will be transferred. Each tool assembly requires a "namegiving component" 
and a "cutting component", which will be set in the component window. 
 
Each tool assembly must be linked to a WinTool machine type. 
 

Figure 11 Add Codes for CAM and Description 
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Special data fields for assemblies  

Tool Orientation Angle (OA) - C14 
This angle is calculated automatically. It is possible to overwrite the calculated by a user defined value. The 
value must be entered in the WinTool user field C14 of the assembly (tag "CAM"). 

Insert position (INSP) - C15 
The position is automatically set to topside (value = 1). If the insert should be positioned underside 
(value = 2), enter 2 in the WinTool user field C15 of the assembly.  

Transferred Flag 
Whenever a tool is exported from WinTool to NX, the geo models will NOT be deleted in the user models 
path, thereafter. Therefore it will not be necessary to generate these models again and again with each 
transfer. If the "transferred flag" in the WinTool assembly window\folder “Geometry” is set, a geo file will not 
be created again. 
 
Note: If a tool assembly will be rebuild in WinTool using the button “rebuild tool assembly data and 
drawing”, the transfer flag will be automatically deleted. 

 
Note: You can use the WinTool Shape module to check the 3D assembly prior to importing it to NX by using 
the shape module that creates a geo file of the tool assembly contour. You find the Shape module in the ex-
port function of the WinTool tool assembly window. 
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Custom Tool Assembly Contour 
If a contour of a tool assembly cannot be created automatically with the Shape-Generator, you can create 
the DXF file manually. 
Note: Only the tool types "Form Mill" (/UG0251) and "Form Drill" (/UG030401) use the geometries of the 
CUT layer to create the cutting tool in NX. 
The HOLDER and SHANK geometries are used in all tool types except for turning tool types. 
 

• Open the tool assembly and use the Shape-Generator button to create a DXF contour. Even if a 
tool is not supported fully by the Shape-Generator, it will create in most cases a contour-DXF, alt-
hough not with all additional details of the custom tool - but with a lot of useful elements in place already: 
holder, extensions, reductions, shank, total length, correct layers, etc. 

• Then modify it with Vector or any other DXF editor until it is exact. You must use the layers CUT, 
NOCUT, and SHANK: 

• The CUT layer is independent from the shank and holder closed contour. It must start and end at the X-
axis (Y=0). Only the first and the last line of the contour are allowed to start/end at X-axis. 

• The SHANK and NOCUT layer together must form a closed contour. It must start and end at the X-axis 
(Y=0). Only the first and the last line of the contour are allowed to start/end at X-axis. 

• When you have finished the modification, you must save the file in the User Models Path with the name 
of the WinTool tool assembly Ident No (e.g. 616089.dxf). Already existing files must be overwritten. 

• Assign the new DXF to the WinTool tool assembly: Check the box “User Model” in the tab “CAM” in the 
row containing "Unigraphics NX". If it is missing, please activate Unigraphics NX in "Settings" > "CAM 
settings" on the main WinTool screen. 

  

NOCUT 

SHANK CUT 

Figure 12 Tool Assembly Contour 
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Custom 3D Tool Assembly  
If the 3D model of the assembly cannot be created automatically because of functional limitations of the 
shape module, no NX Part will be created. If you need a realistic NX Part for simulation, you need to create it 
manually. Proceed as follows: 
 

• Create an assembly within WinTool as usual.  

• On the page “Geometry” of the WinTool assembly activate the flag "User model" in the row "Uni-
graphics/Siemens NX". This will indicate that an independent NX Part is available which should be used 
together with this assembly. 

• Note: The model name in the WT-NX-Interface must be the same as the assembly ID and prefix as con-
figured.) 

 
To create a NX Tool Assembly Part, all the components of the WinTool assembly must have a NX model. If it 
doesn't have one it must be created first, based on a STL model. 
 
Create the missing NX Component models as follows: 

• Create a new model in NX. Use the Item No. as file name.  
Save the file in the NX location for custom specific tool assemblies. The location is stored in  
the NX variable UGII_CAM_LIBRARY_TOOL_GRAPHICS_PATH which is by default  
<NX installation folder>\MACH\resource\library\tool\graphics 

• To import the STL, go to "File" > "Import" > "STL" 

• The axes must be oriented like this: 

 
 

• Place all geometries on layer 1. Use "Format" > "Move to Layer" if necessary. 

• If all NX Components are created, the create the NX Tool Assembly Part as follows: 

• Create a new model in NX. Use the prefix plus the assemblies ID # as filename (i.e. "ID615015.prt") 

Save the file in the NX location for custom specific tool assemblies. The location is stored in  
the NX variable UGII_CAM_LIBRARY_TOOL_GRAPHICS_PATH which is by default  
<NX installation folder>\MACH\resource\library\tool\graphics 

• Import all NX Components of the Tool Assembly, starting with the holder: 
Go to "File" > "Import" > "Part". Select  "WCS" as "Destination Coordinate System" and click "OK". Then 
select the NX Component. Place the component by setting the "Output Coordinates" or by moving it via 
mouse. Repeat until all components are imported 

• The complete Tool Assembly should look like this: 

X 

Z 

Y X 

Z 

Y 

X 

Z 

Y 

Figure 13 3D simulation holder and turning  tool 

Figure 14 3D simulation assembly tool 
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• Add the following attributes to the Tool Assembly 
CAM_TOOL_ATT_X(1) = Tool tip X coordinate 
CAM_TOOL_ATT_Y(1) = Tool tip Y coordinate 

 

Linking NX Parts to the WinTool Database 
Manually created models can be linked to the database to manage them easily and to automatically start NX 
with these parts. Use the hyperlink field implemented for components as well as for assemblies.  
  

Y 

- + 

+ 

- 

X 

Figure 15 Add attributes to Tool Assembly 
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Software Structure 

 

Figure 16 Software Structure 

NXDirectories = Database file directories of NX: 
UGII_CAM_LIBRARY_TOOL_METRIC_DIR, UGII_CAM_LIBRARY_TOOL_ENGLISH_DIR, UGII_CAM_LI-
BRARY_FEEDS_SPEEDS_DATA_DIR  
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Annex 

Troubleshooting 

Machine Tool View adjustment 

Place mouse over column-description and use right click to activate configuration. Unselect unused columns. 

Reload NX Parameters  
NX sometimes does not reload data files. When a tool is not transferred or the 3D model is not created it of-
ten helps to reload the NX configuration file to adjust the environment.  
 
Activate the "Machining" application (Start). Select in the menu section:  
 Preferences  
  Manufacturing 

 

Activate the "Configuration“ tab and select "browse" for "Configuration file". Copy the file "cam_general.dat" 
to "cam_general_datos.dat" and select the copy to be loaded.  
 

                   
Figure 18 Activate the Configuration File 

Next time you want to reload the configuration file you can switch back to the original file. NX will not reload 
the file if the name is the same as the already loaded. 
Sometimes it also helps to additionally reselect the "template set". 

How it looks How you want it 

Figure 17 Is - Should; Machine Tool view 
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Adjust tool import macro for NX 7 and below 
The macro "GetTool.vb" contains instructions that are only supported in NX 7.5 and newer. If you want to 
use the interface with version 7 and below, you must apply the following changes: 
 

1. Open the file "GetTool.vb" in a text editor. Make sure you have write access. It is located in 
<WT-NX-Interface installation directory>\NX Integration\application\ 

2. Go to line 122 and replace the following lines: 
camTool = NXObjectManager.Get(tool) 

camTool.UpdateFromLibrary() 
with this line: 
theUfSession.Cutter.UpdateFromLib(tool) 

3. Save the file 

Error Messages 

 
Figure 19 Error message_no written access 

Cause: The current user doesn't have write access on the NX database directory. 
 
Solution: Write access must be granted to the directory. See the Requirements for a complete list of NX di-
rectories that need write access. 
 
 

 
Figure 20 Error message_older version 

Cause: WT-NX-Interface is used with NX version 7.5 or below. 
 
Solution: The tool import macro must be adjusted. For detailed instructions, see chapter "Adjust tool import 
macro for NX 7 and below" on page 26. 
 
 

 
Figure 21 Error message_older version 

Cause: A version of WinTool below 2009 is used.  
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Figure 22 Notification_older version 

 
Cause: The registry stores the installation path to the WT-NX-Interface. If the path is not found, this error 
message appears.  
 
Solution: Open the registry editor: 

 
Figure 23 Error message_solution 

 
Create the String value and set the installation directory as data: 

 
Figure 24 Registry Editor_create a String value 
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NX File structure 

File types 

*.dat 
These files contain the actual data in the database 

*. def 
These files contain the information on configuring the dialogs 

*. tcl 
These files contain a script in the TCL language controlling the functions found in the dialogs. These files are 
called the event handlers and it is in these event handlers where other TCL files are included. 
 
The actual file paths can be seen by going to Help-→ NX log file. 

NX Windows Environment Variables 
UGII_BASE_DIR 
UGII_ROOT_DIR 
UGII_LICENSE_FILE 

NX internal Environment Variables directory 
$UGII_ROOT_DIR/ugii_env.dat  

Important NX internal Environment Variables  
UGII_CAM_BASE_DIR=${UGII_BASE_DIR}\mach\ 
 
UGII_CAM_CUSTOM_DIR=${UGII_CAM_BASE_DIR}custom\ 
UGII_CAM_RESOURCE_DIR=${UGII_CAM_BASE_DIR}resource\ 
UGII_CAM_LIBRARY_DIR=${UGII_CAM_RESOURCE_DIR}library\ 
 
# tool library 
UGII_CAM_LIBRARY_TOOL_DIR=${UGII_CAM_LIBRARY_DIR}tool\ 
UGII_CAM_LIBRARY_TOOL_ASCII_DIR=${UGII_CAM_LIBRARY_TOOL_DIR}ascii\ 
UGII_CAM_LIBRARY_TOOL_GENIUS_DIR=${UGII_CAM_LIBRARY_TOOL_DIR}genius\ 
UGII_CAM_LIBRARY_TOOL_INCLASS_DIR=${UGII_CAM_LIBRARY_TOOL_DIR}inclass\ 
UGII_CAM_LIBRARY_TOOL_ENGLISH_DIR=${UGII_CAM_LIBRARY_TOOL_DIR}english\ 
UGII_CAM_LIBRARY_TOOL_METRIC_DIR=${UGII_CAM_LIBRARY_TOOL_DIR}metric\ 
 
# Part files for library cutting tools 
UGII_CAM_LIBRARY_TOOL_GRAPHICS_PATH=${UGII_CAM_LIBRARY_TOOL_DIR}graphics\ 
 
# Technology: 
UGII_CAM_LIBRARY_FEEDS_SPEEDS_DIR=${UGII_CAM_LIBRARY_DIR}feeds_speeds\ 
UGII_CAM_LIBRARY_FEEDS_SPEEDS_ASCII_DIR=${UGII_CAM_LIBRARY_FEEDS_SPEEDS_DIR}ascii\ 
 
# Feeds and speeds: feeds_speeds.dat 
# Cutting methods: cut_methods.dat  
# Part Materials: part_materials.dat  
 
# machine tool library 
UGII_CAM_LIBRARY_MACHINE_DIR=${UGII_CAM_LIBRARY_DIR}machine\ 
UGII_CAM_LIBRARY_MACHINE_ASCII_DIR=${UGII_CAM_LIBRARY_MACHINE_DIR}ascii\ 
 
# Setting the value to "1" forces NX to load the tools in the tool library into memory 
# The interface setup creates this Windows environment variable which is used by NX 
UGII_CAM_LIBRARY_TOOL_ASCII_LOAD_LIMIT = 1 
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WT-NX-Interface Configuration file parameters 
Following configuration parameters can be set in the WT-NX-Interface.cfg file (lines starting with a “#” sign 
will be ignored). By running the module, the values will also be stored in the corresponding Windows Regis-
try. Restart NX to make them effective.  
 
OutputPath  Path to write the exchange files to. 

UserModelsPath  Path to write the user model files to. 

SelectCutData Enable/disable (true/false) material based cutting con-

dition selection 

 

ignore_TransferredFlag Ignore transferred flag in CAMtools table (true/false) 

 

T-Prefix Defines a string prefix to be added to LIBREF output 

column 

CustomToolPath Path which contains the custom tool definition files 
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Supported NX tool types 
 

NX 
Nr. 

NX Tooltype 
English 

NX Tooltype 
German 

WinTool 
Classification 

01-01 OD Turning  Aussen - Drehen /UG0101 

01-02 ID Turning  Innen - Drehen /UG0102 

01-11 OD Grooving Aussen - Stechen /UG0111 

01-12 ID Grooving  Innen - Stechen /UG0112 

01-14 Parting  Abstechen /UG0114 

01-21 OD Profiling Aussen halbrund stechen /UG0121 

01-22 ID Profiling  Innen halbrund stechen /UG0122 

01-31 OD Threading  Aussen - Gewindedrehen /UG0131 

01-32 ID Threading  Innen - Gewindedrehen /UG0132 
    

02-01 End Mill  Schaftfräser ohne WPL /UG0201 

02-02 End Mill Indexable  Schaftfräser mit WPL /UG0202 

02-03  Ball mill  Gesenkfräser /UG0203 

02-05 Chamfer mill (>= NX 8.0)  Fasenfräser (>= NX 8.0) /UG0205 

02-31  Thread mill  Gewindefräser /UG0231 

02-12  Face mill (< NX 8.0) Messerköpfe (< NX 8.0) /UG0212 

02-21 T-Slotter  T-Nutenfräser /UG0221 

02-51 
Form Mill 
Uses cutting contour of tool assembly 
shape DXF to create segments 

Formfräser 
Der schneidende Teil der DXF Kon-
tur wird importiert 

/UG0251 

02-90  UG_5ParamCutter  5-Parameter-Fräser /UG0290 

02-91  UG_7ParamCutter  7-Parameter-Fräser /UG0291 

02-92  UG_10ParamCutter  10-Parameter-Fräser /UG0292 

02-93  Barrel mills  Ballenfräser /UG0293 
    

03-01 Twist Drill Spiralbohrer /UG0301 

03-03  Core drills  Aufbohrer /UG0303 

03-04  Step drills Stufenbohrer /UG0304 

03-04 
Form Drill, based on "Step Drill", but 
uses cutting contour of tool assembly 
shape DXF 

Stufenbohrer, bei dem die Stufen aus 
der schneidenden DXF Kontur impor-
tiert werden 

/UG030401 

03-21  Spot Drill  NC - Anbohrer /UG0321 

03-22  Center Drill Zentrierbohrer /UG0322 

03-32  Boring Aufbohrwerkzeug /UG0332 

03-42  Taper Reamer  Kegelreibahle /UG0342 

03-51  Counter Boring  Flachsenkung /UG0351 

03-61  Counter Sinking  Kegelsenker /UG0361 

03-71  Taps  Gewindebohrer /UG0371 

03-41  Reamer  Maschinenreibahle /UG0341 
    

04-02 Probe Messtaster /UG0402 

 Ignore (not in NX)  /UG00 
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History 

4.11.1 
• Added compatibility with NX 12 

4.11 
• Added compatibility with NX 11 

• Corrected custom tool import error 

4.10 
• Added compatibility with NX 10 

• Added support for NX tool type "Probe" 

• Tap tools import: Corrected tip length and added designation 

• Milling tools with a tip angle: Importing tip angle in "End Mill" and "End Mill Indexable" tool types.  

• Corrected import of material name in cutting condition data 

4.9 
• NX 8.0 and newer: Importing tool neck diameter as shank in NX instead of as part of the holder.  

• Corrected import of face mills with button inserts 

• Improved import of custom DXF profiles for tool types "From Drill" and "Form Mill" 

• Corrected custom tool definitions: 

• Using formulas of unused fields in tool class, e.g. "User-1" 

• Corrected unnecessary decimal places when using a formula 

• Added tool point angle to tool class "Core Drill" 

• Setting NX tool database value ZOFF to 0 

• Importing "Adjust Register" and "Cutcom Register" on single tool assembly and machine tools import 

• Added "Coolant Through" flag import 

4.8 
• Corrected import of tool direction 

• Corrected tool list export to WinTool when using "T-Prefix" setting 

• Corrected cutting condition import 

4.7 
• Supports WinTool 2011 – 2014 

• Separated program files and user data 

• Added custom DXF tool assembly contour support 

• Saving NX database files in NX default database directories, therefore removed WT-NX-Reset button 

• Supporting user defined tool assembly datafields using custom tool definition xml 

• Added new tool types "Form Mill" (/UG0251) and "Form Drill" (/UG030401) which use the tool assem-

bly cutting contour to create tool segments/steps 

• Corrected import of W type inserts 

• Included newest version of WT-MakeList (see detailed changes in WT-MakeList manual) 

• Included newest version of WT-ToolExport: 

• Saving selection state of "preferred only" filter 

• Improved readability with high DPI settings 

• Compatible with WinTool 2014 

• Single tool assembly import: Transferring ident-no for t-no if "T-No=Ident No" is activated in the machine 
type 
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4.6 
• Supports WinTool 2013, WinTool 2012 and WinTool 2011 

• Added compatibility with NX 9 and 8.5 

• Corrected tip length of step drill and tip diameter of countersink 

• Minor fixes in holder geometry calculation and tool list creation 

• Simplified configuration of interface buttons in NX 

• NX environment variable UGII_CAM_LIBRARY_TOOL_ASCII_LOAD_LIMIT is set to 1 during installation 

• Included newest version of WT-MakeList (see WT-MakeList manual for details) 

4.5 
• Support for WinTool 2012 

• Included newest version of WT-ToolExport: 

• Resizable search windows 

• Compatible with WinTool 2012 

4.4 
• Renamed interface to WT-NX-Interface 

• Updating instead of adding new tool assembly if it is already in imported in NX 

• Support for WinTool 2011 

• Included newest versions of WT-ToolExport and WT-MakeList module 

• WT-ToolExport: Start-up time with large databases is quicker 

• Corrected import of chamfer mills with corner radius > 0 

• Added tool type "Ignore" (/UG00) for tool assemblies that must be ignored on transfer 

• Improved error handling 

4.3 
• Added compatibility with NX 8.0 

• Added support for new NX tool type "Chamfer mill" 

• Installing WT-MakeList 3.8, updated WT-MakeList tls file version to 2.2.1 

4.2 
• Improved holder geometry transfer 

• Transferring cutcom and length adjust numbers if tool list is imported 

• Added support for drills with flat tip 

• Transferring upper and lower radius of t-slot mill 

4.1 
• Added new WT-ToolExport module 

• Added WT-NX-Interface configuration window 

• Minor update of cutting condition selection window 

• Added compatibility with NX 5.0 

• Added material based cutting condition transfer (SelectCutData = true) 

4.0 Beta 
• Using NX Open .Net API instead of C++ API 

• Added "Reset" button 

• Generating tools with holders instead of toolshapes (.prt) 

• Technology data is always transferred 

• No support of inch tools 
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• No support of quiet mode 

• Disabled progress windows and "put" for highlighted operations 

• Removed obsolete .cfg parameters and 3D Samples for Turning Tools 

3.2.9.8144 
• Support for WinTool 2009 and WinTool 2010 (ToolExport and MakeList) 

3.2.9 
• Support for NX5 and NX6 (signed DLLs) 

3.2.8 
• No more user models are overwritten 

• Diameter now correctly set when tool lists are transferred  

3.2.5 
• Turning tools and extended Tool_Database implemented 

• Lollipop mill supported if classified as barrel mill 

• End mill taper angle from WinTool field E1 transferred with higher priority than from G5  

3.2.2 
• TAPA for Face Mills correctly supported  

• HEI value is automatically reduced to FL if any angle is present 

3.2.1 
• Exchange format changed (no more user9 / user10 fields, new UG fields added) 

• Corner radius of End Mills now transferred to COR1 as well as to LCOR 

• Quarter round mills supported (with negative corner radius) 

• For Shell Mill diameter WinTool diameter A2 is used instead A1 

• Tip Length for center drills correctly supported 

• User field C14 supported for manual setting of Orientation Angel "OA" 

• User field C15 supported for manual setting of  Insert position "INSP" (up/down) 

• X64 support included (as additional file version) 

• Optional export limitation of assemblies within a highlighted operation 

3.1 
• Correction with tool list import 

• Angle E1 correctly supported 

• Corner radius for tools with insert supported 

3.0 
• New shape module implemented (see separate manual). 

• Parameters transferred correctly now for Spot drills, Taps and Face mills  

• User model flag supported 

• Transferred flag supported  

• Tool_database.dat is no longer deleted after import but before next data exchange 

• Layer 5 automatically is set to selectable (visible)  

• Parameter value LOAD_LIMIT=1 is checked during import 

• No more message if transfer was successful  

• Message text is configurable now (for better translation) 

• Shorter timeout when selection is interrupted  

• Inch values and parts are supported  
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• Pathnames with spaces supported 

• Fast and extended tools-search with new ToolExport module 

• Fully SAL and multy-language support with new ToolExport module  

2.8 
• Non metric tools supported (parts for simulation is built as inch model) 

• Cutter radius supported for face mills  

• Pitch and tip angle supported for taps  

• Diameter correctly transferred for spot mills  

• Layer 5 is automatically set to selectable  

• Error message included if UGII_CAM_LIBRARY_TOOL_ASCII_LOAD_LIMIT not set to 1  

• Messages translated to English 

• Timeout after interruption of tool selection reduced  

• No more message if transfer was successful  

• Shipped with new Shape module 1.8 (supporting backside cutting and problem free taps) 

• Updated manual  

2.7 
• Spaces allowed in installation- and exchange path  

• Support for turning tools, spot drills and barrel mills 

• Technology databases are updated during data exchange  

• WT-ToolExport module implemented as replacement for not fully satisfying dll's  

• No more problems with user rights and SQL-server access  

• New WTMakeList module 3.0 implemented (better support for defaults and user rights) 

• Shipped with new Shape module 1.7 (see separate documentation)  

2.6  
• Shipped with new Shape module 1.6.9  

• Tool-ID Prefix implemented (for NX 3 users) 

• Additional UG Tool Types supported 

• Fees&Speeds supported (file replace method)  

• Optional "Transferred-Flag" omitting 

• Proven User-Model handling  

• Geometry definition unified according latest Parts-Geometry-Documentation  
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